Table of Contents

FLIR Camera Controller GUI ........................................................................................................ 1

1.0 Document ............................................................................................................................. 6
  1.1 Revision History .................................................................................................................... 6
  1.2 Scope .................................................................................................................................. 6

2.0 Unpacking the Camera ........................................................................................................... 7

3.0 Basic Accessories .................................................................................................................. 8
  3.1 VPC Module Accessory ...................................................................................................... 8
  3.2 Camera Link Module Accessory .......................................................................................... 9
  3.3 Photon Replicator Board .................................................................................................... 9
  3.4 Tau Replicator Board ......................................................................................................... 9
  3.5 Quark VPC Module Accessory .......................................................................................... 10

4.0 Connecting to the Camera ..................................................................................................... 10
  4.1 FLIR Camera Controller GUI ............................................................................................ 10
  4.2 Physical Connection .......................................................................................................... 11
  4.3 Software Connection ......................................................................................................... 12
  4.4 Digital Data via Camera Link ............................................................................................. 14
  4.5 Troubleshooting the FLIR Camera Controller GUI .............................................................. 16

5.0 Operation of the FLIR Camera Controller GUI ................................................................... 18
  5.1 Menu Bar ............................................................................................................................. 18
  5.2 Status Tab ........................................................................................................................... 19
  5.3 Setup Tab ............................................................................................................................ 20
    Flat-Field-Correction Mode .................................................................................................... 21
    External Sync Mode .............................................................................................................. 23
    Gain Mode ............................................................................................................................. 23
    SSN ...................................................................................................................................... 24
  5.4 Analog Video Tab ................................................................................................................ 25
    Image-Orientation Mode ....................................................................................................... 25
    E-Zoom ................................................................................................................................. 26
    Pan and Tilt .......................................................................................................................... 26
    Polarity/LUT .......................................................................................................................... 27
    Isotherm LUTs ...................................................................................................................... 28
  5.5 Digital Video Tab (for Tau 1.X) .......................................................................................... 30
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.6</td>
<td>Digital Video Tab (for Tau 2 / Quark)</td>
<td>32</td>
</tr>
<tr>
<td>5.7</td>
<td>Ethernet Controls</td>
<td>36</td>
</tr>
<tr>
<td>5.8</td>
<td>Image Capture Tab</td>
<td>36</td>
</tr>
<tr>
<td></td>
<td>5.8.1 Tau 1.X / Tau 2.0 / Quark</td>
<td>36</td>
</tr>
<tr>
<td></td>
<td>Snapshot Viewer</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>5.8.2 Tau 2.1 and Later Releases</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>Max Number of Snapshots</td>
<td>39</td>
</tr>
<tr>
<td>5.9</td>
<td>AGC/DDE Tab</td>
<td>43</td>
</tr>
<tr>
<td></td>
<td>AGC Modes</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>Enhancements</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Digital Detail Enhancement (DDE)</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Active Contrast Enhancement (ACE)</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Smart Scene Optimization (SSO)</td>
<td>45</td>
</tr>
<tr>
<td>5.10</td>
<td>AGC ROI Tab</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>AGC ROI Coordinate Values</td>
<td>48</td>
</tr>
<tr>
<td>5.11</td>
<td>Thermal Tab</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>Spot Meter Controls</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>Isotherms</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>Gain Switch Values</td>
<td>50</td>
</tr>
<tr>
<td>5.12</td>
<td>Radiometry Tab</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>External Parameters</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>Calibration Parameters</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>Blackbody Calibration</td>
<td>52</td>
</tr>
<tr>
<td>5.13</td>
<td>Image Metric Tab</td>
<td>53</td>
</tr>
<tr>
<td></td>
<td>Image Metric ROI Coordinate Values</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>Image Metrics</td>
<td>54</td>
</tr>
<tr>
<td>5.14</td>
<td>Advanced Tab</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>Digital Detail Enhancement (DDE)</td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>FFC Utilities</td>
<td>56</td>
</tr>
<tr>
<td></td>
<td>Shutter-less Gain Switch Calibration</td>
<td>56</td>
</tr>
<tr>
<td></td>
<td>FFC Frame Count</td>
<td>56</td>
</tr>
<tr>
<td></td>
<td>Supplemental Offset</td>
<td>56</td>
</tr>
<tr>
<td></td>
<td>Splash Screen</td>
<td>57</td>
</tr>
</tbody>
</table>
Table of Figures

Figure 1: Tau Camera and VPC Module Accessory Kit ......................................................... 8
Figure 2: Tau Camera Link Module installed on a Tau 640 camera ........................................ 9
Figure 3: Quark Camera and VPC Module Accessory Kit .................................................. 10
Figure 4: BNC to RCA Adapter ......................................................................................... 11
Figure 5: VPC Physical Connections ............................................................................. 11
Figure 6: Device Manager showing proper driver installation .......................................... 12
Figure 7: FLIR Camera Controller GUI Status Tab – Not Connected .................................. 13
Figure 8: FLIR Camera Controller GUI Connection Window Part 1 ...................................... 13
Figure 9: FLIR Camera Controller GUI Connection Window Part 2 ..................................... 14
Figure 10: FLIR Camera Controller GUI Status Tab – Connected ....................................... 14
Figure 11: FLIR Camera Controller GUI – Digital Tab ...................................................... 15
Figure 12: Imperx FrameLink Express Software – Camera Parameters Window ................. 16
Figure 13: FLIR Camera Controller Error Message ............................................................ 16
Figure 14: FLIR Camera Controller – Menu Bar ............................................................... 18
Figure 15: FLIR Camera Controller – Status Tab ............................................................... 20
Figure 16: FLIR Camera Controller GUI - Setup Tab ....................................................... 21
Figure 17: Ramp test pattern example for Top Portion of Ramp Image ............................... 24
Figure 18: FLIR Camera Controller GUI - Analog Video Tab ........................................... 25
Figure 19: Look-Up Table Options (Without Isotherms) ..................................................... 28
Figure 20: Isotherm LUT Scale Example ........................................................................ 29
Figure 21: Look-Up Table Options (with Isotherms) ........................................................ 30
Figure 22: FLIR Camera Controller GUI – Digital Video Tab 1 ........................................ 31
Figure 23: FLIR Camera Controller GUI – Digital Video Tab 2 ........................................ 33
Figure 24: FLIR Camera Controller GUI – Video Capture Tab .......................................... 37
Figure 25: FLIR Camera Controller GUI – Snapshot Viewer ............................................ 38
Figure 26: FLIR Camera Controller GUI – Video Capture Tab Tau 2.1 and later .................. 39
Figure 27 – 8-bit Snapshot Management ..................................................................... 40
Figure 28 – Multiple Bitmap Viewer windows .................................................................. 41
Figure 29 – Snapshot Viewer ....................................................................................... 42
Figure 30 – Snapshot Viewer with digital data .............................................................. 43
Figure 31: FLIR Camera Controller GUI - AGC Tab .......................................................... 43
Figure 32: FLIR Camera Controller GUI – ROI Tab .......................................................... 46
Figure 33: AGC ROI Example ....................................................................................... 47
Figure 34: FLIR Camera Controller GUI – Thermal Tab .................................................. 48
Figure 35: FLIR Camera Controller GUI – Radiometry Tab .............................................................. 51
Figure 36: FLIR Camera Controller GUI – Image Metric Tab ........................................................... 53
Figure 37: FLIR Camera Controller GUI – Advanced Tab .................................................................. 55
Figure 38: FLIR Camera Controller GUI – AGC/DDE (Advanced) ..................................................... 58
Figure 39: FLIR Camera Controller GUI – Bad Pixel Elimination ...................................................... 60
Figure 40: FLIR Camera Controller GUI – Gain Calibration Tab .......................................................... 62
Figure 41: FLIR Camera Controller GUI – Image Capture ................................................................. 63
1.0 Document

1.1 Revision History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>11/2/2011</td>
<td>Initial Release corresponding with GUI version 1.0.0.92</td>
</tr>
<tr>
<td>110</td>
<td>6/4/2013</td>
<td>Update for Tau 2.4 Release with GUI version 1.0.0.106</td>
</tr>
<tr>
<td>120</td>
<td>5/9/2013</td>
<td>Update for Tau 2.7 Release with GUI version 1.0.0.111</td>
</tr>
</tbody>
</table>

1.2 Scope

The FLIR Camera Controller GUI is freely distributed software that is used to configure and control FLIR camera cores such as the Tau, Tau 2, Quark, Photon, and others. This User’s Guide includes Quick Start information for the Tau and Quark as well as detailed descriptions of functions and adjustments for the camera that can be performed using the FLIR Camera Controller GUI.
The FLIR website will have the newest version of this document as well as offer access to many other supplemental resources: http://www.flir.com/cvs/cores/resources/

Here is a sample of some of the resources that can be found:

<table>
<thead>
<tr>
<th>Document Title</th>
<th>Document Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tau Quick Start Guide</td>
<td>102-PS242-01</td>
<td>Quick Start Guide for first-time use</td>
</tr>
<tr>
<td>Quark Quick Start Guide</td>
<td>102-PS241-01</td>
<td>Quick Start Guide for first-time use</td>
</tr>
<tr>
<td>FLIR Camera Controller GUI User’s Guide</td>
<td>102-PS242-02</td>
<td>Detailed Descriptions for functions and adjustments for FLIR cameras using the FLIR Camera Controller GUI</td>
</tr>
<tr>
<td>Tau 2 Product Specification</td>
<td>102-PS242-40</td>
<td>Product specification and feature description</td>
</tr>
<tr>
<td>Quark Product Specification</td>
<td>102-PS241-40</td>
<td>Product specification and feature description</td>
</tr>
<tr>
<td>Tau 2 Electrical IDD</td>
<td>102-PS242-41</td>
<td>Written for Electrical Engineers to have all necessary information to interface to a Tau 2 camera</td>
</tr>
<tr>
<td>Quark Electrical IDD</td>
<td>102-PS241-41</td>
<td>Written for Electrical Engineers to have all necessary information to interface to a Tau 2 camera</td>
</tr>
<tr>
<td>Tau 2/Quark Software IDD</td>
<td>102-PS242-42</td>
<td>Written for Software Engineers to have all necessary information for serial control of Tau 2 and Quark</td>
</tr>
<tr>
<td>Assorted Mechanical Drawings and Models</td>
<td>Various</td>
<td>There are drawings and 3D models for various camera configurations for mechanical integration</td>
</tr>
<tr>
<td>Application Notes</td>
<td>Various</td>
<td>Written for Systems Engineers and general users of advanced features such as Gain Calibration, Supplemental FFC Calibration, NVFFC Calibration, Camera Link, On-Screen Symbology, AGC/DDE explanation, Camera Mounting, Spectral Response, Optical Interface for lens design, and others.</td>
</tr>
</tbody>
</table>

There is also a large amount of information in the Frequently Asked Questions (FAQ) section on the FLIR website: http://www.flir.com/cvs/cores/knowledgebase/. Additionally, a FLIR Applications Engineer can be contacted at 888.747.FLIR (888.747.3547).

2.0 Unpacking the Camera

When unpacking the camera, please heed customary electrostatic-discharge (ESD) sensitive device precautions including static-safe work station and proper grounding. The camera is placed in a conductive anti-static bag to protect from electrostatic-discharge damage and safely packaged to prevent damage during shipping.

Disassembling the camera can cause permanent damage and will void the warranty. Operating the camera outside of the specified input voltage range or the specified operating temperature range can cause permanent damage. The camera back is not sealed. Avoid exposure to dust and moisture. The camera contains electrostatic-discharge-sensitive electronics and should be handled appropriately.
3.0 Basic Accessories
The Tau Camera can be simply used with either the VPC Module Accessory (FLIR PN 421-0039-00) or the Camera Link Module Accessory (FLIR PN 421-0046-00). The Quark camera can be used with the Quark VPC Module (FLIR PN TBD). These accessories provide an easy way to evaluate the camera core and access analog and, in the case of the Camera Link Module, digital video during development. These and other accessories can be found at http://www.flirshop.com.

3.1 VPC Module Accessory
The VPC module accessory includes USB-A to USB-mini B cable for power and communications, USB power supply, European power adapter, MCX-to-BNC cable for analog video, and mounting screws.

Socket head cap screws (M1.6 × 0.35 × 6 mm)

Figure 1: Tau Camera and VPC Module Accessory Kit
(USB Power Supply and European Power adapter not pictured)
3.2 Camera Link Module Accessory
The Camera Link module is an expansion board for the Tau camera that matches the functionality of the VPC Module and adds the ability to access digital data via Camera Link connection. It is possible to use the Camera Link Module with a Quark camera using a Tau Replicator Board. The Camera Link module takes CMOS-type digital data from the Tau camera and converts it to Camera Link. In order to use a Camera Link module for acquisition of data, first enable the CMOS XP Bus Output using the FLIR Camera Controller GUI. This module does not include a Camera Link cable, frame grabber, or capture software.

Figure 2: Tau Camera Link Module installed on a Tau 640 camera

3.3 Photon Replicator Board
Photon Replicator Board adapts the Tau camera's native 50-pin Hirose connector to the 30-pin SAMTEC connector used on FLIR's Photon cameras. The replicator board makes the Tau camera electrically pin-compatible to a Photon camera, including the provision for operating the Tau camera over the same input voltage range as the Photon camera: 5-24VDC. Refer to the Photon 640 User's Manual for more details including pin definition.

A cast magnesium spacer and 4 socket-head machine screws are included.

3.4 Tau Replicator Board
Tau Replicator Board (FLIR PN 250-0462-09) adapts the Quark camera's native high-density 60-pin SAMTEC connector to the 50-pin Hirose connector used on FLIR's Tau cameras. The replicator board makes the Quark camera electrically pin-compatible to a Tau camera. Refer to the Quark Product Specification for more details.

A cast magnesium spacer and 4 socket-head machine screws are included.
3.5 Quark VPC Module Accessory

The Quark VPC module accessory includes USB-A to USB-mini B cable for power and communications, USB power supply, European power adapter, MCX-to-BNC cable for analog video, and mounting screws.

![Quark Camera and VPC Module Accessory Kit](image)

**Figure 3: Quark Camera and VPC Module Accessory Kit**

4.0 Connecting to the Camera

This section describes installation of necessary software, physical camera connections, and software connection to the camera.

4.1 FLIR Camera Controller GUI

The FLIR Camera Controller GUI provides communication between a PC and a Tau camera using either the USB interface or some other means of serial communication.

1. Computers with an older version of the FLIR Camera Controller GUI should first uninstall it using the Windows Uninstall utility via the Windows Control Panel before proceeding with this installation.
2. The newest version of the FLIR Camera Controller GUI can be found at the following URL: [http://www.flir.com/cvs/cores/resources/software/tau/](http://www.flir.com/cvs/cores/resources/software/tau/)
3. Click on the link to download the GUI and save it to the desired computer.
4. Extract the file using WinZip or other software. This can typically be done by right-clicking on the zip file and selecting “Extract”.
5. Open the directory where the saved file is and double-click “setup.exe”.
6. Walk through the installation steps.
7. When the primary installation is completed, a message will prompt to install Silicon Laboratories drivers. This portion of the installation is necessary for using a USB connection to the camera.
8. The program will install to **Start→All Programs→FLIR Systems→Camera Controller GUI**

### 4.2 Physical Connection
This section describes physical connections to the camera and assumes that either the VPC or Camera Link Accessory Module is being used with the camera.

1. Plug the accessory directly into the rear of the camera. There is a white 50-pin connector that will mate. Use the included socket head cap screws to secure the expansion board to the camera. These will insert on either side of the 50-pin connector. The VPC module uses M1.6 × 0.35 × 6 mm screws and the Camera Link module uses M1.6 × 0.35 × 8 mm screws. Using longer screws could damage the camera.

2. Connect the analog video cable to the VPC or Camera Link Module on the back of the Tau Camera. There is an MCX mini coaxial connector on the back of the accessories. The opposite end of the cable has a standard coaxial connector. Connect this to the video input of an analog monitor. It may be necessary to use a BNC Female to Phono Plug (RCA) Adapter. These are readily available at electronics stores and allow the camera to be connected to the standard yellow video input on a monitor.

![Figure 4: BNC to RCA Adapter](image)

3. Connect the USB-mini B cable to the VPC Module or the Camera Link Module and the USB-A end to the computer. (If sound is enabled on the computer, a chime will sound and a notification that the device has been connected will pop up).

![Figure 5: VPC Physical Connections](image)

4. Analog video should appear within a few seconds after connecting the USB cable. Verify analog video is displayed on the monitor to ensure the camera is properly powered.
5. Additional Information: Access the Device Manager to verify proper driver installation and identify communications port. **Connection issues are most often caused by attempting to use the wrong COM Port to connect to the camera.**
   a. Right-Click on “My Computer” and select “Manage”. This is typically either on the desktop or available through the start menu.
   b. Select “Device Manager” on the left Pane.
   c. Expand the tree for “Ports (COM & LPT)”.
   d. Note the COM Port number used for Silicon Labs. The following example shows COM3.

![Device Manager showing proper driver installation](image)

**Figure 6: Device Manager showing proper driver installation**

### 4.3 Software Connection

This section describes simple communication with the camera using the FLIR Camera Controller GUI and assumes that the camera is connected to the PC using a USB cable and either the VPC or Camera Link Accessory Module.

1. Run the FLIR Camera Controller GUI by clicking on the start menu and accessing **Start→All Programs→FLIR Systems→Camera Controller GUI.** (The software may take up to 30 seconds to load the first time.

2. When the GUI first opens, it will display “Not Connected” on the bottom left. The first step is to connect to the camera.
3. Connect to the camera by selecting **Tools → Connection**

Figure 8: FLIR Camera Controller GUI Connection Window Part 1
4. Select Serial (RS-232), select 921600 as the Baud Rate for fastest communication, and click Next. If there is only one serial communication port on the computer, the button will say Finish.

![FLIR Camera Controller GUI Connection Window Part 2](image)

Figure 9: FLIR Camera Controller GUI Connection Window Part 2

5. Select the Com port seen in the Device Manager and click Finish.

6. The GUI will now automatically connect to the camera and refresh information in the software. The status LED will turn green and it will display “Connected” on the bottom left. It is also possible to retrieve the part number and serial number of the camera from this screen.

![FLIR Camera Controller GUI Status Tab – Connected](image)

Figure 10: FLIR Camera Controller GUI Status Tab – Connected

4.4 Digital Data via Camera Link

This section describes digital data acquisition with the Camera Link accessory and assumes that all prior sections have been successfully completed

1. Connect one end of the Camera Link cable to the camera. The camera connection is a Mini-Camera Link connector and frame grabbers may use either standard or Mini-Camera Link. It is possible to purchase cables that have mini connectors on both ends or standard on one end with mini on the other.

2. The camera must be configured to output CMOS digital data in order for the Camera Link accessory to work. This can be done by clicking “Video” on the left pane of the GUI, “Digital Video” tab on the top, and selecting “CMOS” for the XP Bus Output. Select either 14-bit or 8-bit,
depending upon preference. 8-bit data has the AGC applied and looks similar to the analog video image. 14-bit data does not have AGC applied.

![FLIR Camera Controller GUI](image)

**Figure 11: FLIR Camera Controller GUI – Digital Tab**

3. Once these changes are made, it is a good idea to save settings to make them power cycle persistent. This can be done on the Setup Tab by clicking the “Save Settings” button.

4. The digital data complies with Base Camera Link standards and will be compatible with most off-the-shelf Camera Link frame grabbers. FLIR has tested the ImperX FrameLink Express frame grabber ([http://imperx.com/frame-grabbers/framelink-express](http://imperx.com/frame-grabbers/framelink-express)) and the Matrox Solios Camera Link frame grabber ([http://www.matrox.com/imaging/en/products/frame_grabbers/solios/solios_ecl_xcl_b/](http://www.matrox.com/imaging/en/products/frame_grabbers/solios/solios_ecl_xcl_b/)). It is important to note that this module provides access to digital data only and the other portions of the Base Camera Link specifications are not met. Camera control, external frame sync, and power through the Camera Link connector are not supported. With simple hardware modifications, it is possible to route communications through the Camera Link interface rather than through USB. It is also possible to access the Tau camera’s external sync channel on the Camera Link accessory through appropriate modification. Please consult a FLIR representative for details on these modifications.

5. The FLIR Camera Controller GUI allows for control of the Tau camera, but does not support Camera Link frame capture and so third-party software must be used. The ImperX frame grabber
includes FrameLink Express software that allows for recording single or multiple images (BMP, JPG, TIF, and RAW) as well as standard AVI clips. Configuration requires selecting: “1 TAP, L->R” for the tap reconstruction, selecting the same bit depth that was chosen in the FLIR Camera Controller GUI in step 2, and clicking “Learn” to discover the number of digital pixels available.

6. Click Apply and Start Grab

![Camera Parameters Window]

Figure 12: Imperx FrameLink Express Software – Camera Parameters Window

7. Note: If the image appears to have very little contrast, the output is likely in 14-bit mode. If that is the intended setting, use the histogram feature in the frame-grabber software to change the display range. Otherwise, set the Tau camera to 8-bit Digital Output Mode and the frame-grabber to 8-bit capture mode. Click “Apply” in the frame grabber software. The camera will now use its built in AGC functionality that is accessible from the AGC tab in the FLIR Camera Controller GUI.

4.5 Troubleshooting the FLIR Camera Controller GUI

If the FLIR Camera Controller GUI does not link with the camera, there might be a popup shown below which indicates that the GUI has not been able to communicate with the camera.

![Error Message]

Figure 13: FLIR Camera Controller Error Message

If this is the case, verify the following:

- The USB Cable is properly connected to both the computer and the Accessory Module so that there is a green LED illuminated on the accessory.
- Verify the proper port was selected if it was not detected automatically. Select Advanced, then Next in the Tools→Connection dialog box. Also, try disconnecting and then re-connecting the cable to the PC. If the GUI was launched before the cable was connected, close the GUI, connect the cable, and then re-launch the GUI.

- The Baud rate must be set in the Tools→Connection dialog box. The Tau camera supports Baud rates of 57600 and 921600. The Tau camera automatically detects if the Baud Rate of the first incoming message is either 57600 or 921600 and will communicate at that Baud Rate until reset.

- The Port may be occupied by another application. Shut down any other applications that may be using the port. Also, multiple instances of the FLIR Camera Controller GUI Program can be instantiated using different ports so be sure the camera that is interested in being controlling is actually connected to the physical port that was verified in the Device Manager in Section 3.2, step 5.

- Verify that the camera is powered by checking that the camera is producing an image on an analog monitor. On cameras with a shutter installed, listen for the sound of the FFC at startup. There will be a clicking sound as the shutter is moved in and out of the field of view in the first 5 seconds after power is applied.

- If the GUI says SWIR Camera Controller on the top, try to use Camera→Select to select LWIR-MWIR rather than SWIR. If this option is not present, the GUI will need to uninstall using the Windows Uninstall utility via the Windows Control Panel and delete the Program Files directory (C:\Program Files (x86)\Flir Systems\Camera Controller GUI). The latest .NET Framework will also need to downloaded and installed from Microsoft (http://www.microsoft.com/net/download). It is best to use the client profile from the web. Once this is updated, install the Camera Controller GUI and use Camera→Select to select FLIR rather than SWIR.

If serial communication cannot be initiated with the camera after verifying these items, refer to the frequently asked questions (FAQ) at http://www.flir.com/cvs/cores/faqs/tau/all/. Additionally, a FLIR Applications Engineer can be contacted at 888.747.FLIR (888.747.3547).
5.0 Operation of the FLIR Camera Controller GUI
This section describes operation of the FLIR Camera Controller GUI and explains adjustments that can be made to the camera.

5.1 Menu Bar
The FLIR Camera Controller GUI has a classic menu bar where drop down menus are displayed.

**File**: The file menu has the option to Exit. This will close the GUI and can also be performed by clicking the x on the top right corner.

**View**: Select Log to display a log at the bottom of the GUI. This does not display all commands sent to the camera, but rather displays connection information. Click Refresh to refresh the GUI. This can also be done with the F5 function key on a keyboard and is useful for fields like FPA temperature that will be changing with time.

**Camera**: Select Connect to connect to a camera using the same communications parameters that were used previously. If connection cannot be established, it will ask to retry or open the connection wizard. Select Disconnect to open the COM port that the GUI is occupying and disconnect from the camera. This can be useful if using other software to communicate with the camera. The Select submenu allows selection of different camera types. The type “FLIR” can be used for Quark, Tau 2, Tau, and Photon.

**Tools**: Select Clear Log to clear the log that can be displayed using the View menu. Select Connection to open the connection wizard. This allows the ability to configure communication settings such as COM Port and baud rate. Select Settings to configure the GUI. It is possible to configure the GUI to automatically connect at startup using the previous settings, allow multiple instances to be open at once, or change communication timing parameters.
Help: Open the Camera Controller User Guide in the default pdf viewer. The latest version of this document installs in the Program Files directory. Select SDK Documentation to view help information for the Photon SDK that can be used with Tau, Tau 2, Quark, Quark 2 and Photon. The SDK does not install with the GUI, but must be purchased separately.
Select About Camera Controller to open a separate window with version information for the GUI and the camera.

About: The GUI Framework is the version of the GUI. The Main App is the software version of the camera. The version in the example is v15.20.15.9. The firmware is v15.22.14.12. Click Details to view versions for each individual dll in the GUI.

5.2 Status Tab
When the FLIR Camera Controller GUI successfully links to the camera, the window shown below will be visible. At the bottom of the application window, there is the Camera and FPA status. The GUI provides six tabs allowing for camera control as described below.
Figure 15: FLIR Camera Controller – Status Tab

**Camera Part #:** This indicates the specific camera configuration connected. Please refer to the appropriate Product Specification for details understanding the part number. If the first two digits of the Part Number are 41, 42, or 43, the camera connected is a FLIR Tau 1.X (previous releases of Tau 320 and Tau 640). If the first two digits are 46, 47, 48, 66, 67, 68 the camera connected is a FLIR Tau 2. If the first two digits are 50, the camera connected is a FLIR Quark.

**Camera Serial #:** This is the serial number of the camera currently connected to the FLIR Camera Controller GUI.

**FPA Temperature:** The camera’s Focal Plane Array (FPA) temperature.

**Note:** The connection status, Camera status, Camera Part #, and FPA Size are displayed at the bottom of all tabs.

**5.3 Setup Tab**

The Setup tab, shown below, provides the ability to set and save basic settings in the camera.
Flat-Field-Correction Mode: Flat field correction (FFC) is a process whereby off set terms are updated to improve image quality. This is done by presenting a uniform temperature (a flat field) to every detector element. While imaging the flat field, the camera updates correction coefficients, resulting in a more uniform array output. During an FFC, the analog and digital video is frozen for less than 500 ms, and resumes automatically thereafter. For cameras that include internal shutter, the shutter is closed and then reopened during this time.

Repeating the FFC operation often prevents the imagery from appearing “grainy”. This is especially important when the camera temperature is fluctuating, such as immediately after turn-on or when ambient temperature is drifting. FFC can be controlled manually at any time using the Do FFC command button.

After any FFC event, it is possible to store the currently-applied map to non-volatile memory via software command, in which case that map will be applied automatically at the next power-up. This feature, commonly referred to as Non-Volatile Flat Field Correction (NVFFC), is particularly useful for shutterless configurations. If the camera is in automatic FFC mode, it will resume the FFC schedule five seconds after startup. Use of this feature requires access to the Advanced Tab. Refer to Section 4 or the NVFFC Application Note for more details.

The camera provides three FFC modes:
**Auto:** In the Automatic FFC mode, the camera performs FFC whenever its temperature changes by a specified amount or at the end of a specified period of time (whichever comes first). When this mode is selected, input windows are available in the FLIR Camera Controller GUI for specifying the temperature change and the number of frames that trigger automatic FFC. The temperature change is specified in degrees C, with valid values in the range 0 to 100 in 0.1 degree increments. The time period is specified by counting analog video frames between FFC events (Start counting after the last FFC is complete) with valid values in the range 0 to 30,000 frames. Setting the FFC Interval to 0 frames means that elapsed time will not be used to trigger an FFC. The second set of Auto FCC parameters labeled Low Gain apply to cameras that support Low Gain Mode. If there is an NVFFC saved, the camera will load this correction at startup and will resume normal operation after five seconds.

**Note:** FLIR recommends using the factory default values for the two automatic-FFC parameters if possible. These values were selected to maintain a high degree of image quality over all camera operating conditions. Automatic mode is not recommended for shutterless configurations because there is no assurance that the core will be imaging a uniform source when it initiates an automatic FFC.

**Manual:** In Manual FFC mode, the camera does not perform FFC automatically based on specified values of temperature change or expired time. The FFC will be performed once upon startup if there is no saved NVFFC, then again using the internal shutter whenever they do FFC button is clicked. If there is an NVFFC saved, this will be loaded at startup. When transitioning across camera temperatures of 0°C 40°C, and 65°C, a Do FFC command is recommended in order to maintain image quality.

**External:** In External FFC mode a uniform source must be placed in front of the camera. This feature is useful if there are lens or lens mount non-uniformities that are not corrected by an internal FFC. The camera will not perform an FFC process on startup, but it will load a saved NVFFC if present. Many customers have found that the palm of their hand or a table is an adequate uniform source to perform an External FCC.

The camera displays an on-screen symbol called the Flat Field Imminent Symbol prior to performing an automatic FFC operation. It can be seen in the image to the right as the blue square in the upper right of the video output. By default, it is displayed 60 frames (2 seconds in LVDS) prior to the FFC operation. The duration of the FFC Imminent Symbol can be set using the FFC Warn Time setting in the Analog Video Tab. Setting the Warn Time to less than 15 frames turns off the warning (see Section 5.4).
**External Sync Mode:** FLIR cameras provide the ability to either accept or output a frame synchronization pulse. Refer to the appropriate Electrical IDD for more information on pin definition and pulse timing.

- **Disabled:** The camera runs at its native frame rate and it will not output a frame synchronization pulse.

- **Slave:** The camera will accept a frame synchronization signal on the interface connector. The camera output will be frozen if the camera is in slave mode and no external synchronization signal is received.

  **Note:** External sync should only be used for digital output. Performance is greatly reduced when using external sync for analog video.

- **Master:** The camera will output a frame synchronization signal on the interface connector when configured as a master.

**Gain Mode:** Some FLIR cameras support low gain mode. This mode will provide a higher intrascene range, but will lower the sensitivity. When the camera is in Auto Mode, it will switch between high and low gain modes based on the gain switch values configured on the Thermal Tab (see section Error! Reference source not found.).

**Operating Mode:** The camera will freeze the analog frame imaged when Frozen is selected. Live video will cease and the frozen frame will persist. To return the camera to live video, select Real-Time video mode. “Frozen” cannot be saved as the power-on default state.

**Save Settings:** After using the FLIR Camera Controller GUI to change Camera modes and settings to desired values, use the Save Settings button to store the current selections as new power-up defaults. The next time the camera is powered; the camera will remember these saved Settings. If the Save Settings button is not clicked, any changes made via the FLIR Camera Controller GUI will be valid only for the current session. Cycling power to the camera will revert to the previously saved settings.

**Note:** The Save Settings button applies to changes made anywhere in the GUI, not only the Setup Tab.

**Factory Defaults:** The Factory Defaults button restores the camera’s settings to the initial values specified in the FLIR factory. To save the factory default settings as the power up defaults, first click the Factory Defaults button, then click the Save Settings button.

**Reset Camera:** The Reset Camera button performs a soft reset that restarts the camera software.

**Test-Pattern:** A Test-Pattern mode is provided to adjust display properties and/or for diagnostic purposes (for example, to verify the core is providing a valid output). The Test-Pattern mode will not persist over a power cycle.

- **Off:** No test-pattern is provided in this mode. This is the normal operation mode.
Ramp: In this mode, the test pattern shown below and in the Color/LUT section that follows is provided at the analog and digital data channels.

![Ramp Test Pattern](image)

Figure 17: Ramp test pattern example for Top Portion of Ramp Image

(Digital values shown apply to the optional 14-bit digital data stream.)

The above ramp pattern repeats 19 times in the complete 640 × 512 image. For a 320 × 256 resolution camera, the pattern will repeat 4 times.

Note: The ramp test pattern is intended primarily for verifying the output of the digital data channel. The pattern will not necessarily look as shown above when displayed on an analog video monitor, particularly if an Automatic Gain Control (AGC) mode other than Automatic is selected. The above image is a horizontal slice of the full displayed image.

Scratch Pad: Tau2 cameras support an internal scratch pad that can be used to save notes in the field for testing purposes.

SSN: The Tau2.7 and Quark 2.0 release support Silent Shutterless Non-Uniformity Correction (SSN). There are multiple presets for different use cases. The original use case was for shutterless cameras and as the usefulness of the algorithm was observed, the use cases were extended to cameras with a shutter. SSN is a spatial pattern noise reduction algorithm that uses motion within a scene to determine if a pixel is noise or true scene information. If a pixel is determined to be noise then a correction map will increment its value towards returning the pixel towards the local average.

There are four preset for both use cases of shutter and no shutter: no motion, low motion, medium motion and high motion. The user must determine the use case that their camera will be used in and select a preset accordingly. The largest differences between the presets are what constitutes motion and the maximum allowed correction for the algorithm. High speed vehicles would find the most benefit from the high motion default while a fixed pole security application would be considered a no motion scenario. Choosing an appropriate default will help avoid any possible image artifacts.
5.4 Analog Video Tab

The Analog Video tab on the FLIR Camera Controller GUI, shown below, provides the ability to configure the camera’s analog output.

![FLIR Camera Controller GUI - Analog Video Tab](image)

**Figure 18: FLIR Camera Controller GUI - Analog Video Tab**

**Image-Orientation Mode:** Two Image-Orientation mode selections are provided. Select one or both to change the orientation of the video image.

**Invert:** The normal image is flipped vertically. The pixel on the upper-left corner of the detector array is displayed on the lower-left corner of the video display in Invert mode. This is the recommended mode when the core images the scene via a vertical fold mirror or when the camera is mounted upside down. Invert applies to all output channels.

**Revert:** The normal image is flipped horizontally. The pixel on the upper-right corner of the detector array is displayed on the upper-left corner of the video display. This is the recommended mode when the core images the scene via a horizontal fold mirror, when used in a rear-facing application intended to simulate the view through a rear-view mirror, and when the camera is mounted upside down. Revert applies to analog and BT.656 for Tau 1.X (older configurations of Tau 320 and Tau 640), and to all output channels (i.e., also CMOS, and LVDS) for Tau 2 / Quark.

**Note:** If the camera is in Automatic or Manual FFC mode, an FFC will be performed automatically when the image orientation mode is inverted. Adjusting image orientation should always be followed by a flat-field correction in all modes.
Zoom: Tau1 and Quark 1 cameras have built in discrete steps of zoom capability with on screen symbology. For cameras with 160 x 128 resolution, the maximum zoom level is 2x. For cameras with 324 x 256 resolution or 336 x 256, the maximum zoom level is 4x. For cameras with 640 x 512 resolution, it is possible to zoom to 8x. The zoom level is a function of the current analog output resolution. For example, a Tau 320 in NTSC has an output of 320 x 240. 2x zoom mode will use the center 160 x 120 and interpolate to achieve an NTSC output resolution of 640 x 480.

**E-Zoom:** The Tau 2.1 and Quark 2.0 later releases provide the capability for continuous zoom. The user can adjust the zoom with the arrows or enter the desired zoom multiplier in the box provided. The maximum zoom is based on the resolution of the camera as described above.

**Pan and Tilt:** The user may pan left or right and tilt up or down while zoomed. The zoom level is a function of the current analog output resolution and defaults to interpolating the center pixels described in the Zoom section above. The Pan and Tilt shifts this interpolated window by up to 40 pixels in any of the four directions: up, down, left, or right.

Fine: Enabling Fine will limit the Pan and Tilt to 20 pixels in all directions to provide a smaller step in pan/tilt on the order of a single pixel.

Center: Pressing the Center button will return the Pan and Tilt coordinates back to the center of the image.

**FFC Warn Time:** The camera displays an on-screen symbol called the Flat Field Imminent Symbol prior to performing an automatic FFC operation (See Section 5.3). Use this function to set the number of analog video frames (33ms NTSC, 40ms PAL) during which the warning will be displayed. The time period, specified in frames, can range from 0 to 30,000 frames. The factory Setting of 60 frames equates to a two second warning in NTSC. Setting the FFC Warning to less than 15, turns off the warning.

**Video On/Off:** This feature allows the ability to turn off the analog video output which will result in power savings (approximately 75mW).

**Video Standard:** Choose the video standard for the system the camera will be used in. It is necessary to perform an FFC after changing the video standard. This can be done using the Do FFC button on the Setup Tab. Changing the video standard affects the operating frame
rate of the camera in both the analog and digital output.

Averager: Some FLIR cameras are equipped with a 60Hz sensor. This control will not be present for cameras that do not support this feature. In averager-enabled mode, the core performs automatic “smart” averaging of pairs of frames from the detector array to achieve a 30Hz NTSC or runs the sensor at 50Hz and averages to achieve 25Hz PAL. The averager operation is designed to reduce blur by only averaging a given pixel’s output if the difference from one frame to the next is small enough to be considered noise. Bypassing the average will allow for 60Hz digital data to be captured.

Video Color: Choose color mode or monochrome mode for the analog video. In monochrome mode, color encoding is not used and video low-pass filtering is disabled in the analog output signal, which results in slightly higher bandwidth data to the display system. This mode can be used to improve image sharpness when color palettes and color symbols are not required.

**Note:** For transmission of the analog video channel, a coaxial cable with 75 ohm characteristic impedance is required. The analog output is current mode and a 75 Ohm termination is required. This termination is present in most display devices.

Analog Symbology: Tau 2.7 and Quark 2.0 and later releases support the option to disable symbology in the analog output. This would remove all symbology from being overlaid in the analog output including FFC imminent, zoom symbology and radiometric symbols if the camera is being used in a radiometric mode.

**Polarity/LUT:** The camera detects and images the temperatures in a given scene. Within the camera, these temperatures are mapped (as determined by the AGC algorithm selected) to a range of 0 to 255 values. In a black and white display mode, this range is converted to shades of gray with 0 being totally black and 255 being totally white. The 0 to 255 gray shades range can also be referenced to a Look-Up Table (LUT) permanently stored in the camera to convert the scene to a color video image. Different LUTs are available to change the appearance of the displayed image. The most common selection is either White Hot (hotter objects appear brighter than cooler objects in the video display) or Black Hot (hotter objects appear darker than cooler objects). Since the difference between these two modes simply reverses the choice of darker or lighter for temperature extremes, this is sometimes referred to as Polarity. Other color LUTs are available as shown below.
Options shows each of the LUTs as displayed in Test Pattern Ramp Mode starting with the upper left: White Hot, Black Hot, Fusion, Rainbow, Glowbow, Ironbow1, Ironbow2, Sepia, Color1, Color2, Ice Fire, and Rain. Select one of these LUTs from the pull-down menu to view the image displayed using the chosen LUT. Setting the Polarity/LUT mode will not affect the CMOS or LVDS digital data output for releases prior to Tau 2.4. Beginning with the Tau 2.4 release, color for 8-bit CMOS and LVDS can be enabled on the Digital Video Tab (see section 5.6).

<table>
<thead>
<tr>
<th>Cold</th>
<th>Cold</th>
<th>Cold</th>
<th>Cold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hot</td>
<td>Hot</td>
<td>Hot</td>
<td>Hot</td>
</tr>
<tr>
<td>White Hot</td>
<td>Black Hot</td>
<td>Fusion</td>
<td>Rainbow</td>
</tr>
<tr>
<td>Cold</td>
<td>Cold</td>
<td>Cold</td>
<td>Cold</td>
</tr>
<tr>
<td>Hot</td>
<td>Hot</td>
<td>Hot</td>
<td>Hot</td>
</tr>
<tr>
<td>Glowbow</td>
<td>Ironbow1</td>
<td>Ironbow2</td>
<td>Sepia</td>
</tr>
<tr>
<td>Cold</td>
<td>Cold</td>
<td>Cold</td>
<td>Cold</td>
</tr>
<tr>
<td>Hot</td>
<td>Hot</td>
<td>Hot</td>
<td>Hot</td>
</tr>
<tr>
<td>Color1</td>
<td>Color2</td>
<td>Ice Fire</td>
<td>Rain</td>
</tr>
</tbody>
</table>

Figure 19: Look-Up Table Options (Without Isotherms)

Simple experimentation with this feature while viewing the video image will provide familiarity. Remember to click the Save Settings button on the Setup Tab to save the LUT settings as the default at power-up.

**Isotherm LUTs:** Updated Isotherm LUTs were introduced with the Tau 2.4 release. The applied LUT is changed when Isotherms are enabled on the Thermal Tab (see section 5.11 for more details).

**Polarity / Palette:** In Tau 2.4 and later, the Isotherms have an updated drop down menu that has the associated names in it with an attached – Iso to help distinguish between which state the Isotherms are in.

Isotherm LUT Scale: The camera detects and images the temperatures in a given scene. Within the camera, these temperatures are mapped (as determined by the AGC algorithm selected) to a range of 0 to 255 values. In WhiteHotIso mode, this range is converted to shades of gray with 0 being totally black and 127 being totally white. The first
Isotherm temperatures are mapped to 128 to 175, the second Isotherm temperatures are mapped to 176 to 223 and the third Isotherm temperatures are mapped to 224 to 255.

The two MidRangeIso LUTs scale 0 to 127 for the first half of the gray scale, then the first two Isotherm values use 128 to 175 to map yellow and then the scale continues on in gray scale until reaching the max value of 255.

**Figure 20: Isotherm LUT Scale Example**

Options show each of the LUTs that map to the 256 bits available to represent a pixel starting with the upper left: WhiteHotIso, BlackHotIso, FusionIso, RainbowIso, GlowboIso, IronbowWhiteHotIso, IronbowBlackHotIso, Sepialso, MidRangeWhiteHotIso, MidRangeBlackHotIso, IceFireIso, RainbowHighContrastIso, GreenHotIso and RedHotIso. With Isotherms enabled and appropriate thresholds set, select one of these LUTs from the pull-down menu to view the image displayed using the LUT desired. The setting of the Polarity/LUT mode will not affect the CMOS or LVDS digital data output for releases prior to Tau 2.4 With the Tau 2.4 release, 8-bit digital color can be enabled on the Digital Video Tab (see section 5.6).
<table>
<thead>
<tr>
<th>Cold</th>
<th>GlowboIso</th>
<th>Cold</th>
<th>IronbowWhiteHotIso</th>
<th>Cold</th>
<th>IronbowBlackHotIso</th>
<th>Cold</th>
<th>SepiaIso</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="GlowboIso" /></td>
<td><img src="image2.png" alt="IronbowWhiteHotIso" /></td>
<td><img src="image3.png" alt="IronbowBlackHotIso" /></td>
<td><img src="image4.png" alt="SepiaIso" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="GlowboIso" /></td>
<td><img src="image2.png" alt="IronbowWhiteHotIso" /></td>
<td><img src="image3.png" alt="IronbowBlackHotIso" /></td>
<td><img src="image4.png" alt="SepiaIso" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="GlowboIso" /></td>
<td><img src="image2.png" alt="IronbowWhiteHotIso" /></td>
<td><img src="image3.png" alt="IronbowBlackHotIso" /></td>
<td><img src="image4.png" alt="SepiaIso" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="GlowboIso" /></td>
<td><img src="image2.png" alt="IronbowWhiteHotIso" /></td>
<td><img src="image3.png" alt="IronbowBlackHotIso" /></td>
<td><img src="image4.png" alt="SepiaIso" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 21: Look-Up Table Options (with Isotherms)**

### 5.5 Digital Video Tab (for Tau 1.X)

The camera offers digital output that can be configured in four modes. Changing these modes will have no effect on the analog (NTSC or PAL) signal. Refer to the appropriate Electrical IDD for information on how to access digital video for LVDS, BT.656, and CMOS.

**Note:** If using a Tau 2 or Quark camera, skip ahead to Section 5.6.
Camera Type: This field displays the camera type that is currently connected to the GUI. The active array output displayed is the necessary setting for a frame-grabber.

Camera Digital Output: Select the desired digital data format. These settings will affect both the LVDS data and the XP Bus data. The XP Bus hosts the CMOS or BT.656 data.

**Off:** The digital data stream coming from the camera is turned off. Setting the Digital Output Mode to Off will disable both the LVDS data and digital data available on the XP Bus. This will result in a power savings of approximately 20mW.

**8-bit:** Data is provided after application of the current Automatic Gain Control (AGC) and Dynamic Detail Enhancement (DDE). The 8-bit data is essentially a digital version of the same data provided on the analog video channel, but LVDS and CMOS data does not include symbology, LUT, or zoom.

**14-bit Filtered:** Data is provided prior to video processing modes in the 8-bit data described above. The 14-bit data is the filtered data to include the Dynamic Detail Enhancement (DDE) and bad pixel replacement. This data may appear to have very low contrast when saving 16-bit TIFF files, use post-processing to reduce the dynamic range.
14-bit Raw: Data is provided prior to all video processing and does not include the Dynamic Detail Enhancement (DDE) or bad pixel replacement. This data may appear to have very low contrast when saving 16-bit TIFF files, use post-processing to reduce the dynamic range.

Note: AGC will only affect the digital data output if Camera Digital Output Mode is set to 8-bit data.

XP Bus Output: The camera has a set of pins defined as eXPansion (XP) pins that are configurable by the user. These pins can be used for BT.656 data, CMOS data, or discrete I/O pins. This control allows for configuration of these pins for digital data. Refer to the Electrical IDD for more information on using these pins and to find timing diagrams for data formats.

- **BT.656**: The BT.656 parallel output is a common interface which will drive many LCD displays. The data is digitally encoded to match the NTSC/PAL video and will have AGC, DDE, symbols, and color included. This data is only available in 8-bits.

- **CMOS**: The CMOS interface is a parallel output that allows the user to access 8-bit AGC corrected data or 14-bit data. Changing the data format in the Camera Digital Output section will affect the CMOS data.

- **None**: The XP Bus will not output any digital data. This results in a power savings of 10mW.

Note: Enabling digital data on the XP Bus will disable the use of many of the Discrete I/O functions.

5.6 Digital Video Tab (for Tau 2 / Quark)
The camera offers digital output that can be configured. Changing these modes will have no effect on the analog (NTSC or PAL) signal. Refer to the appropriate Electrical IDD for information on how to access digital video for LVDS, BT.656, and CMOS.

Tau 2 and Quark cameras support setting bit-depth of the CMOS and LVDS data channels separately, previous FLIR cameras set the bit-depth simultaneously. The FLIR Camera Controller GUI will automatically detect the camera type that is connected and display the proper settings.

When the FLIR Camera Controller GUI is connected to a Tau 2.7 or Quark 2.0 camera, the Digital Video Tab will be displayed as follows:
Camera Type: This field displays the camera type that is currently connected to the GUI. The active array output displayed is the necessary setting for a frame-grabber.

**XP Bus Control:** Select the desired digital data format for the CMOS digital data.

- **Off:** The XP Bus Output will also be changed to None and the XP Bus will not output any digital data. This results in a power savings of 10mW.
- **8-bit:** Data is provided after application of the current Automatic Gain Control (AGC) and Dynamic Detail Enhancement (DDE). The 8-bit data is essentially a digital version of the same data provided on the analog video channel, but CMOS data does not include symbology. With the Tau 2.4 release LUTs and digital E-Zoom are user selectable.

- **14-bit Filtered:** Data is provided prior to video processing modes in the 8-bit data described above. The 14-bit data is the filtered data to include bad pixel replacement. This data may appear to have very low contrast when saving 16-bit TIFF files, use post-processing to reduce the dynamic range.

- **8-bit Bayer Color:** The Tau 2 core provides up to 15 user-selectable palettes (also referred to as look-up tables or LUTs). For the Tau 2.0 and 2.1 releases, the palette selection applies to the analog and BT.656 output data. For the Tau 2.4 release and later, the palette selection
applies to the analog, BT.656 output data, and is software selectable for the 8-bit CMOS and LVDS output data. With the digital colorization mode enabled, the 8-bit digital data is colorized via Bayer encoding. Bayer encoding allows colors to be produced with 8-bit resolution, instead of the traditional 24-bit (RGB) representation. By assigning each pixel a red, green, or blue value and averaging the neighboring pixel values, the color components of the specified pixel can be decoded. Multiple filter arrays can be applied to create the encoding.

16-bit YCbCr Color: The Tau 2.7, Quark 2.0 and later releases also support YCbCr encoding through the XP bus CMOS interface. The 16-bit YCbCr output contains both the chrominance (upper bits) and luminance (lower bits) for the 8-bit digital color data in a single pixel. For more information on YCbCr color encoding view the Tau2 product spec rev 140.

8-bit YCbCr Color (Double-clocked): The other YCbCr CMOS option supported in Tau 2.7, Quark 2.0 and later releases is an 8-bit output that is double clocked. The order and type of subsampling is selectable and discussed further below.

XP Bus Output: The camera has a set of pins defined as “XP” that are configurable by the user. These pins can be used for BT.656 data, CMOS data, or discrete I/O pins. This control allows for configuration of these pins for digital data. Refer to the appropriate Electrical IDD for more information on using these pins and to find timing diagrams for data formats.

BT.656: The BT.656 parallel output is a common interface which will drive many LCD displays. The data is digitally encoded to match the NTSC/PAL video and will have AGC, DDE, symbols, and color included. This data is only available in 8-bits.

CMOS: The CMOS interface is a parallel output that allows the user to access 14-bit pre-AGC data or post-AGC 8-bit data (including colored digital outputs).

None: This will also change the CMOS Control to off and the XP Bus will not output any digital data. This results in a power savings of 10mW.

Note: Enabling digital data on the XP Bus will disable the use of many of the Discrete I/O functions.

LVDS Control: Select the desired digital data format for the LVDS digital data.

Off: The camera will not output any LVDS digital data. This results in a power savings of 10mW.

8-bit: Data is provided after application of the current Automatic Gain Control (AGC) and Dynamic Detail Enhancement (DDE). The 8-bit data is essentially a digital version of the same data provided on the analog video channel, but LVDS data does not include symbology, LUT, or zoom.
14-bit Filtered: Data is provided prior to video processing modes in the 8-bit data described above. The 14-bit data is the filtered data to include the Dynamic Detail Enhancement (DDE) and bad pixel replacement. This data may appear to have very low contrast when saving 16-bit TIFF files, use post-processing to reduce the dynamic range.

8-bit Bayer Color: This enables Bayer encoding mentioned above in the XP Bus digital output section.

8-bit Digital Channel Colorization Controls: The order of subsampling and encoding in the 8-bit digital color outputs are user selectable.

**Bayer Order:** The Bayer order is software selectable with the following options: ‘GR’, ‘GB’, ‘BG’, and ‘RG’. The order is defined by the top two pixels from left to right in the pattern. Below is an example of a ‘GR’ pixel.

```
G R
B G
```

**YCbCr Sub-sampling:** The type of sub-sampling is user selectable through the software and can be 422 centered or 422 cosited.

**YCbCr Order:** The order of luminance and chrominance is user selectable through software with either chrominance first (CbYCrY) or luminance first (YCbYCr).

8-bit Digital Channel Options: Tau 2.4, Quark 2 releases and later provide more options in the 8-bit digital color than just colorization.

**Digital E-Zoom:** Tau 2.1 later Tau2 releases provide the continuous electronic zoom capability in analog video. The Tau 2.4, Quark 2 and later releases includes the selectable option to apply the E-Zoom feature to the 8-bit digital output. The user can adjust the zoom with the arrows or enter the desired zoom multiplier in the box provided on the Analog Video Tab discussed in section 5.4 of this document. Enabling digital zoom for 8-bit LVDS and CMOS outputs requires the camera to use a buffered digital output.

**Note:** Both LVDS and CMOS buffered 8-bit digital outputs are interpolated up to a 640x512 digital output regardless of the native resolution and use either an output of 30Hz (NTSC) or 25Hz (PAL). For 9Hz cameras, frames are replicated to reach this frame rate. Example: A 9Hz 336x256 camera in NTSC using 14-bit output would have a 336x256 digital output at 7.5Hz, but switching into the buffered 8-bit digital output would cause the digital output to be 640x512 at 30Hz.
Note: This 8-bit digital E-Zoom function is not available in the 14-bit digital output; therefore the digital output bus must be configured to 8-bit to access the feature.

Symbols Enable: Tau 2.7, Quark 2 releases and later provide the ability to enable symbol overlay in the digital output that acts identically to the analog symbol overlay. Digital symbols require the camera to use a digital colorization as well as a buffered digital output which the GUI enables by first selecting digital Ezoom enabled.

14-bit T-Linear: T-Linear is only available with cameras configured with Advanced Radiometry. In normal mode, with T-Linear disabled, the Tau camera outputs digital data linear in radiometric flux. In T-Linear mode, the Tau camera outputs digital data linear in scene temperature. The T-Linear feature applies to the 14-bit CMOS and LVDS channels and is software selectable. Two resolution modes are selectable: high resolution (.04° Kelvin/count) and low resolution (.4° Kelvin/count). It is suggested to use Low resolution T-Linear when the camera is in Low Gain Mode and High resolution in High Gain Mode (see section 5.3 for more information on Gain Mode).

5.7 Ethernet Controls
This tab is used with cameras that have an Ethernet interface. The Tau and Quark families don’t have an Ethernet interface is not discussed in this document.

5.8 Image Capture Tab
The Image Capture tab on the FLIR Camera Controller GUI allows the capture of images to camera memory for retrieval to a host computer.

5.8.1 Tau 1.X / Tau 2.0 / Quark
Note: If using Tau 2.1 or later, skip to the next section.

The images stored in the camera as 14-bit and the FLIR Camera Controller GUI will apply an AGC to display in 8-bits. (Note the AGC applied in the GUI does not necessarily match the camera’s AGC algorithm.) The GUI allows the user to save either 8-bit bmp images with AGC applied or 14 bit tiff images. Snapshots are taken sequentially and it is best to first erase snapshots to be certain that the next snapshot taken will occupy memory location 1.
Figure 24: FLIR Camera Controller GUI – Video Capture Tab

**Take Snapshot**: Takes snapshots sequentially. It is possible to take multiple snapshots to be retrieved at a later time.

**Retrieve Snapshot**: Snapshot # is retrieved and a new window is opened to display the captured snapshot.
Figure 25: FLIR Camera Controller GUI – Snapshot Viewer

**Snapshot Viewer:** Image information, such as minimum and maximum value, is given in 14-bit values, but the image displayed has a plateau histogram equalization applied and is displayed as 8-bit.

**Save As:** Used to save the image to the computer being used. A new Save As dialog is opened to allow selection of save location and select 8-bit Bitmap or tiff for 14-bit.

**Image:** This is selected by default when window is first opened and displays an image in the snapshot window.

**Data:** This displays an array of pixel values in the Snapshot Viewer. This will take some time to load when the button is pressed. It is possible to select a set of pixels by clicking and dragging or use Ctrl+a to select all pixels. It is then possible to use Ctrl+c to copy and Ctrl+v to paste into a spreadsheet program for analysis.

**Erase Snapshot:** Snapshots will stay in the camera until erased. For Tau 1.X and Tau 2.0, the camera can store a maximum of 3 snapshots. This button will erase all the snapshots from the camera, allowing new snapshots to be taken. This function will take some time and the GUI will update the status when complete. Do not disconnect power while erasing memory.

**Note:** When connected to 640 configurations of the Quark camera, the Erase Snapshot button will not be present. The 640 configurations of Quark do not support saving snapshots to non-volatile memory.
single snapshot can be saved to volatile memory, and it is automatically overwritten each time “Take Snapshot” is clicked such that it is not necessary to first click the “Erase Snapshot” button.

5.8.2 Tau 2.1 and Later Releases

The Tau 2.1 release introduced the option to capture, download, playback, and manage 8-bit snapshots.

---

**Figure 26: FLIR Camera Controller GUI – Video Capture Tab Tau 2.1 and later**

**Capturing Snapshots:** Select the “Bmp8” or the “Comp14” option from the *Snapshot Type* dropdown menu to specify whether an 8-bit snapshot of 14-bit snapshot is desired. To capture a snapshot select the “Take Snapshot” button: ![Take Snapshot Button](image). This button captures a snapshot of the specified type and saves it in the next available slot in memory. When memory is full and the “Take Snapshot” button is selected, an error will be reported to indicate that the memory must be erased before it is possible to continue capturing snapshots.

**Max Number of Snapshots:** In the Tau 2.1 release and later there is more memory allocated to snapshots. For Tau 2 320 and 336 approximately 100 8-bit snapshots can be stored, approximately 20 8-bit snapshots for Tau 2 640, and a maximum of 255 8-bit snapshots can be stored for Tau 2 160.
**Note:** The 14-bit and 8-bit snapshots occupy the same memory location, and the above values for approximate number of 8-bit snapshots assume there are no 14-bit snapshots also stored. If the user commands a snapshot while simultaneously recording the first, the second capture command will be ignored and only the initial snapshot will be saved.

**Erase Snapshots:** Snapshots will stay in the camera until erased. This button will erase all the snapshots from the camera, allowing new snapshots to be taken. This function will take some time and the GUI will update the status when complete. Do not disconnect power while erasing memory.

**Note:** Erase Snapshots will erase both 8-bit and 14-bit snapshots simultaneously. Ensure that any desired snapshots are saved before erasing all snapshots with this button.

**Bmp8 Snapshots:** On the “Image Capture” tab, specify the Snapshot Type specified as “Bmp8” in the drop-down menu. The button appears to display the snapshots previously captured in memory and offer options for playback, viewing, and saving. Once selecting the “Manage Snapshots” button, the Image Selector window will appear displaying the snapshots sequentially. Note that a snapshot must be selected (highlighted) to enable the buttons at the bottom of the pop-up window which allow saving, viewing, and playing back the stored snapshots. For convenience, once in the Image Selector window, the snapshots can be selected with either a mouse-click or the user’s arrow keys.

![Image Selector Window](image.png)

**Figure 27 – 8-bit Snapshot Management**

The snapshots can be uploaded and saved from the camera to the user’s PC or network from the Image Selector window in multiple user-convenient manners. From the Image Selector window, select the
desired snapshot. Type in the destination folder or browse to the desired location using the following button: . Once the destination has been selected and the desired snapshot has been highlighted the snapshot can be saved using the following methods:

- Select the snapshot and use the “Save Selected” button from the Image Selector window (figure 27, #1)
- Right-click on the snapshot in the Image Selector window and a select “Save” from the drop-down list (figure 27, #5)
- Drag and drop the selected snapshot from the Image Selector window into the desired location

A pop-up window with a progress bar will indicate the download status, and the window will disappear when the download is complete.

Similar to saving snapshots, there are multiple ways to view a snapshot from the Image Selector window. To view a snapshot, select the desired snapshot and use one of the following intuitive methods:

- Select the “View Selected” button (figure 27, #2) in the Image Selector window
- Right-click on the snapshot and select “View” from the drop-down list (figure 27, #5)
- Simply double-click on the snapshot

A progress bar will appear briefly while the image is being retrieved, and then a separate Bitmap Viewer window will open displaying the selected snapshot, similar to figure 23 in previous section. Note that the snapshot can be saved from the Bitmap Viewer window also, in addition to the ways previously mentioned.

Note: that multiple snapshots can be viewed simultaneoulsy; each snapshot will appear in its own separate viewer window as shown below.

![Multiple Bitmap Viewer windows](image)

**Figure 28 – Multiple Bitmap Viewer windows**

**Playback:** It is also possible to playback a specific snapshot on the analog video output of the camera. From the Image Selector window, select the desired snapshot and select the “Playback Selected” button . Right-clicking on the desired snapshot and selecting “Playback” from the drop-down list will also result in snapshot playback.
The desired snapshot will be displayed on the analog video for an unlimited amount of time. To return the analog video to live imaging, select the “Live Video” button from the Image Selector window.

**Comp14 Snapshots:** For Snapshot Type specified as “Comp14” in the drop-down menu the “Retrieve Snapshot” button appears to provide viewing and saving capabilities. The Snapshot Number will begin with one regardless of the number of 8-bit snapshots stored in memory before it – the numbering scheme only refers to the 14-bit snapshots stored in memory.

After selecting the “Retrieve Snapshot” button for the desired Snapshot Number, a progress bar will appear during loading, and finally the Snapshot Viewer window will appear, as shown in figure 8. A cross-hair symbol is applied for the user’s mouse location in the viewer window; the information bar at the bottom of the window displays the coordinates and digital value of the pixel currently pointed at (figure 29, #1). The minimum, maximum, and average pixel value with respect to the entire array are also displayed in the information bar.

The options at the top of the window will allow the user to save the images via the “Save As” button (figure 29, #2) and view the per pixel 14-bit data via the “Data” button (figure 29, #3). Figure 24.b shows per pixel data versus x and y coordinates displayed in the Snapshot Viewer; the data may be copied and exported for external use.

![Figure 29 – Snapshot Viewer](image-url)
5.9 AGC/DDE Tab
The AGC tab controls the Automatic Gain Control (AGC) mode or algorithm along with selectable parameters. Parameters for a given mode are contextually made available depending on which mode is selected. The Region of Interest (ROI) for the AGC mode is adjustable as well (see section 5.10).

Figure 30 – Snapshot Viewer with digital data

Figure 31: FLIR Camera Controller GUI - AGC Tab
AGC algorithms take 14-bit data and create a transfer function to create 8-bit data that can be displayed on a monitor allowing up to 256 shades of grey on a monochrome image.

**Note:** The default mode (Automatic) along with the default parameter settings for the Automatic AGC mode have been proven to offer the best image quality for generalized scene imaging. It may be possible to tune the AGC to achieve a better image for a given scenario. Also, be aware that it is possible to make AGC adjustments that will configure the camera to produce no 8-bit image (all black or all white). Restoring the Factory Defaults on the Setup Tab will return the camera to its factory default state.

**AGC Modes:** There are three standard AGC algorithms for Image-Optimization. There is an Application Note available on the web that describes in more detail how to tune the AGC.

**Automatic:** This is the most sophisticated algorithm and for most imaging situations, the best all-around choice. This factory default along with the default parameter settings should be used in general imaging situations. In Automatic, image contrast and brightness are optimized automatically as the scene varies. This mode provides an AGC which is based on a histogram-equalization algorithm.

This algorithm analyzes the scene content in real time and redistributes the dynamic range of the scene. The goal of this redistribution is that every one of the 255 bins of display dynamic range has an equal number of pixels in it. This method tends to give better scene contrast under conditions where the scene statistics are bimodal (for example, a hot object imaged in a cold background. It should be noted that the heat range in a given scene is not divided evenly across the grey levels sent to be displayed. Instead, the AGC algorithm analyzes the scene and distributes the dynamic range to best preserve statistical scene content (populated regions of the histogram) and display a redistributed scene representation.

**Manual:** In this mode, image Contrast (gain) and Brightness (level) are entered completely manually via the sliders. The scene is mapped using a linear transfer function. Upon entry into the manual mode, currently-stored values of brightness and contrast are applied (i.e. the power-on defaults or the last saved values). The brightness adjustment is ranges from 0 to 16383 and spans the 14-bit data.

**Linear Histogram:** Image contrast and brightness (gain and level) optimized automatically based on scene statistics using a linear transfer function. The Linear Histogram algorithm uses scene statistics to set a global gain and offset (contrast and brightness) for the image. Upon entry into the linear histogram mode, the currently-stored values are applied (i.e. The power-on defaults or the last saved values).

**Note:** In Manual mode the brightness setting must be updated as the camera temperature changes. To avoid this issue, it is recommended to use Automatic or Linear Histogram modes when possible. Also, AGC mode will only affect the digital data output if the Digital Video output mode is set to 8-bit data. The 14-bit digital data bypasses the AGC sections of digital processing.
AGC Presets: These presets apply only to the Automatic AGC algorithm and set predefined values that are stored in the GUI. These presets have been empirically determined for different scenarios. These settings are intended to be used as guidelines and are not guaranteed to be the optimum values for any particular scenario. It is recommended to fine-tune settings for preference and scene conditions (see section 5.15).


**Contrast** – The contrast (gain) has a range from 0 to 255.

**Brightness** – The brightness (offset) ranges from 0 to 16383.

**One-shot** – The One-shot brightness adjustment button can be used to set the brightness in Manual mode. This finds the mean of the 14-bit histogram and sets it as the value for the brightness.

**Fine** – The fine adjustment narrows the range of the slider to allow the slider to move in finer step sizes allowing for more accurate adjustments in the GUI.

Enhancements: The Tau2.7 and Quark 2.0 releases brought new AGC and image processing algorithms to the FLIR compact core lines. The new algorithms provide more autonomy of the algorithms and new empirically found presets have proven to work for typical use cases. More controls are available in the advanced AGC/DDE tab discussed in section 5.15. The presets work for most use cases, but not all users have the same definition of “good” image quality and the three enhancements provided on this tab have the greatest influence over a wide range of scenes.

**Digital Detail Enhancement (DDE)**: DDE is typically used in the dynamic (or automatic) mode where only one threshold is used to determine the enhancement on a per scene basis. Dynamic DDE ranges from -20 to 100. -20 to -1 soften the image, zero is off and 1 to 100 sharpens the image and helps accent edges and other high frequency spatial details.

**Active Contrast Enhancement (ACE)**: The Active Contrast Enhancement (ACE) feature provides a contrast adjustment dependent on the relative scene temperature. ACE thresholds greater than 0 impart more contrast to hotter scene content and decrease contrast for colder scene content (e.g. sky or ocean). ACE threshold less than 0 do the opposite by decreasing contrast for hotter scene content and leaving more of the gray-scale shades to represent the colder scene content. ACE can range from -8 to 8 where -8 decreases contrast in darker regions while +8 increases contrast in darker regions.

**Smart Scene Optimization (SSO)**: The Smart Scene Optimization (SSO) value defines the percentage of the histogram that will be allotted a linear mapping. Enabling this feature facilitates the avoidance of irradiance level compression, which is specifically important for bi-modal
scenes. With SSO enabled, the radiometric aspects of an image are better preserved (i.e. the difference in gray shades between two objects is more representative of the difference in temperature). SSO helps to set how linear the HEQ and information based AGC algorithms are allowed to be to provide the highest amount of perceived contrast in every scene. SSO is a percent and can range from 0 to 100%.

5.10 AGC ROI Tab
FLIR cameras allow the user to set a Region of Interest (ROI) or a rectangular area of pixels on the sensor array that the AGC algorithm will use for its calculations. The AGC ROI applies to the Automatic and Linear Histogram algorithms. The ROI can be set for either the entire frame size (-320, 256, 320,-256) or some smaller portion. The ROI tab provides both a Window Editor and text entry coordinates to control the size and location of the Region of Interest (ROI). The Set button must be clicked for any changes to take effect. The AGC ROI is one of the largest factors in improving image quality. It can be used to ignore the sky or other large objects that would otherwise be used for calculation of AGC.

The AGC ROI has minimum size limitations that are dependent on the Plateau and Zoom settings. When the zoom level is increased and/or the Plateau value is decreased, a very small AGC ROI may need to be increased in size to maintain proper AGC corrected video.

Figure 32: FLIR Camera Controller GUI – ROI Tab
Window Editor: Use the mouse to drag the green ROI rectangle to any location on the FPA. The size of the ROI rectangle (in pixels) is displayed. To change the size of the ROI rectangle, drag one of the corner or side bubbles. The Set button must be clicked for changes to take effect.

Snapshot: In cameras configured with the ability to take snapshots, this feature allows snapshots to be taken and viewed as the background to aid in setting the ROI for a particular scene. Below is the ROI encompassing the entire FOV and the second has the ROI cropped to improve contrast on the portion of the scene most important to the user.

Figure 33: AGC ROI Example
**AGC ROI Coordinate Values:**
The settings use an X-Y coordinate system with (0, 0) being at the center of the sensor array. The upper two numbers marked (left, top) are the pixel coordinates of the upper left corner of the ROI rectangle. The lower two numbers marked (right, bottom) define the lower right corner of the ROI rectangle. The example to the right shows a full screen ROI for a 640x512 camera. The Set button must be clicked for changes to take effect.

**Note:** The AGC ROI coordinates are static relative to the image orientation. If the image in (b) was inverted, then the AGC ROI would still be cropped to exclude the sky in the inverted image and the increased contrast would still be visible on the land portion of the image.

### 5.11 Thermal Tab

For cameras that support Spot Meter temperature reading and Isotherm settings, the Thermal Tab will appear on the left pane of the GUI. This is dynamically determined by the GUI and will not be present for cameras that do not support this functionality.

![Figure 34: FLIR Camera Controller GUI – Thermal Tab](image)
Spot Meter Controls: The Spot Meter uses a subset of pixels to calculate temperature of a target in the scene. Typically, this is the center four pixels.

Mode: Sets the Spot Meter to display temperature in Fahrenheit, Celsius, or off. When this is enabled, the camera will display a spot in the analog video and BT.656 if analog symbols are enabled and will be present in 8-bit buffered digital output if digital symbols are enabled and will show the temperature measurement region.

Digital: Enables a digital temperature display in video outputs that support symbology and gives a numerical temperature reading.

Thermometer: Enables the on-screen thermometer display in video outputs that support symbology. This gives a thermometer style symbol that updates with temperature.

Temperature: Reading of current temperature in Spot Meter. This can be refreshed with View→Refresh or the F5 function key or the Get Temperature button.

Isotherms: Isotherms are false color that is added when a pixel is in a certain region. For older Tau cameras, there are only two Isotherm regions available and the Middle section will not be applicable. In the Tau 2 there are three Isotherm regions available: Upper, Middle and Lower. In Tau2.7, Quark 2.0 and later releases there is a fourth isotherm that will limit the top range of the isotherms, reducing saturation artifacts.

Percentage: Set the thresholds of each isotherm color region using percentage of the full dynamic range of the camera. The dynamic ranges differ between Celsius and Fahrenheit as well as between High Gain and Low Gain.

Celsius: Set the temperature threshold of each isotherm color region.

Example: In the example on the right with the White Hot Isotherm LUT, any object in the scene with a temperature below 70C will be grayscale, anything between 70C and 80C will be colorized with a yellow scale, anything between 80C and 90C will be colorized with an orange to red scale, and anything above 100C will be colorized solid red.
Gain Switch Values: For cameras with low gain mode, there is an auto gain feature that will sense when it is saturating in high gain and automatically switch into low gain to give more dynamic range. When the camera senses that the scene is below a threshold it automatically switches back into high gain always trying to optimize scene dynamic range. These thresholds for switching between high and low gain can be configured. In the example to the right, the camera will switch from its normal operating high gain mode to low gain mode when 15% of the AGC ROI is greater than 140C. It will not switch back to high gain mode until 95% of the AGC ROI has dropped below 120C. It is important to keep separation between threshold values and hysteresis on percent of population to prevent rapid switching between gain modes.

Note: This function uses the active AGC ROI for this calculation. Refer to Section 5.10 for information on changing the AGC ROI.

Radiometry Shutter Mode: When the camera performs a flat field correction (FFC) using the shutter it also adjusts the radiometric offset to match the temperature of the shutter. The Tau 2.7, Quark 2.0 and later releases support three different modes of setting the shutter temperature used to calculate the radiometric parameters.

Auto: The camera will use the estimated temperature of the shutter. This is the default setting for all Tau and Quark cameras.

User: For shutter-less Tau or Quark configurations, one option is for the user to provide an external shutter of a known temperature and operate in “External” FFC mode such that the FFC only occurs on user command. For radiometric accuracy, the user must change the shutter temperature mode from the “automatic” mode default to the “user” mode and specify the temperature of the external shutter.

Static: Without the capability to provide a FFC in run-time operation of the camera, the “static” shutter temperature mode for radiometry should be selected. The “static” radiometry mode requires one initial calibration with a black body of a known temperature that stores the associated parameters for radiometric measurements even if no FFC is performed again. The “static” radiometry mode is intended for a shutter-less camera, operating in “external FFC” mode (although the user is never expected to command FFC in run-time) with a non-volatile FFC (NVFFC) stored.

For manually calibrating the “static” shutter temperature mode, the procedure below should be followed. All software commands described in the procedure are available in the Camera Controller GUI.

Shutter-less Radiometric Calibration:

1. Allow the camera and black body source to reach thermal equilibrium
2. Set the FFC mode to “External”
3. Set the shutter temperature mode to “user” mode
4. Set the shutter temperature to the temperature of the black body source
5. Perform an FFC with the black body covering the entire field of view and verify the spot meter reading now matches the temperature of the black body
6. Save the NVFFC
7. Set the shutter temperature mode to “static” mode
8. Save the settings
9. Reset the camera and verify the spot meter reading continues to match the temperature of the black body

5.12 Radiometry Tab
In Tau 2.1, Quark 2 releases and later, cameras that support Spot Meter temperature reading and Isotherm settings, the Radiometry Tab will appear on the Thermal Tab in the GUI. This is dynamically determined by the GUI and will not be present for cameras that do not support this functionality. The Radiometry Tab is used for radiometry calibrations in the field.

![Figure 35: FLIR Camera Controller GUI – Radiometry Tab](image)
**External Parameters:** These parameters can be set by the user if the ambient conditions at the time of the Radiometry Calibration are different than the presets from the factory. These are only recommended for advanced users who have knowledge of the parameters in their system. In the Tau 2.4, Quark 2.0 and later releases, there are five new external parameters present on the Radiometry and Image Metric tabs including Window Temperature, Atmospheric Transmission, Atmospheric Temperature, window Reflection and the Temperature Reflected in Window. The defaults values are shown to the right.

**Calibration Parameters:** These are lens specific parameters. Once these parameters are set for the specific lens, gain mode and the number of blackbodies, the camera is ready for a Radiometry Calibration.

**Blackbody Calibration:** These are the two forms of Radiometry Calibrations used in the field after cameras leave the factory.

**Single Blackbody:** This requires one blackbody with a known temperature.

**Two Blackbody Calibration:** This requires two blackbodies with known temperatures, with a minimum temperature difference of 20 degrees Celsius.

**Save Settings:** This allows the settings for the External and Calibration Parameters as well as the Radiometry Calibration for an individual lens to persist through a power cycle.

**Note:** Using the Save Settings button on this tab will also save any other settings on any other tab that have been changed. Be sure that the settings that have been chosen are the final settings desired.
5.13 Image Metric Tab

For cameras that support Advanced Radiometry, the Image Metric Tab will appear on the Thermal Tab of the GUI. This is dynamically determined by the GUI and will not be present for cameras that do not support this functionality.

**External Parameters:** These are the same parameters on the Radiometry Tab. See section 5.12 for more information.

Window Editor: Use the mouse to drag the green ROI rectangle to any location on the FPA. The size of the ROI rectangle (in pixels) is displayed. To change the size of the ROI rectangle, drag one of the corner or side bubbles. The Set button must be clicked for changes to take effect.

Snapshot: In cameras configured with the ability to take snapshots, this feature allows snapshots to be taken and viewed as the background for the Window Editor described above. This helps improve cropping for scene specific dimensions.
**Image Metric ROI Coordinate Values:** The default settings for the Image Metric ROI are the center four pixels. With this Tab the Image Metric coordinates can be set to the entire array or any arbitrary rectangle or line defined by the user. These coordinates are invariant to image orientation.

![Image Metric ROI Coordinate Values](image)

**Image Metrics:** This section computes and displays Image Metric statistics. These measurements are based off of the Image Metric ROI coordinates discussed above. The min and max values and locations are reported as well as the average and standard deviation. The display can be read in units of raw counts or a more intuitive form of degrees Celsius or Fahrenheit. These statistics are updated upon pressing the Get button.

![Image Metrics](image)

### 5.14 Advanced Tab

The Advanced Tab contains many features that can be considered to be for advanced users. For this reason, a special keystroke and password is required to display the Advanced Tab. The keystroke is **Ctrl+Shift+a** and the password is [www.flir.com](http://www.flir.com). After the keystroke is performed, the following dialog will appear. Note that the text in the following image is added and a password typed will display as asterisks.

![Advanced Tab Keystroke](image)

This is only intended for sophisticated users and it is possible to break the camera if the incorrect operation is performed.
Digital Detail Enhancement (DDE): DDE is an advanced nonlinear image processing algorithm that preserves detail in high dynamic range imagery. The detail is enhanced so that it matches the total dynamic range of the original image making the details more visible. Use Factory Defaults to recover from inappropriate settings.

In a high contrast scene, the gain will be higher than in a low contrast scene. This allows faint details to be visible in high contrast scenes without increasing temporal and fixed pattern noise in low contrast scenes. The DDE filter operates independently from the AGC and will enhance edges without affecting brightness or contrast.

**Filter Gain:** When the algorithm determines detail it gain that detail up by the filter gain and ranges from 0 to 65535. When in manual mode this setting needs to be set by the user, in dynamic DDE mode this is automatically updated based on scene content.

**Filter Control:** The filter control is the threshold that the algorithm uses to determine what detail is for a given scene and ranges from 0 to 255. When in manual mode this setting needs to be set by the user, in dynamic DDE mode this is automatically updated based on scene content.

**Spatial Control:** The spatial control is the parameter that controls the dynamic DDE mode. The valid range of Dynamic DDE setting is from -20 to 100 with 0 being the neutral setting where the filter has no effect. Settings below 0 will soften the image reducing the appearance of sharp edges. Typical factory settings are between 10 and 30. Use the slider to adjust the setting, or select the text field and type in the desired setting.
Note: In 14-bit Raw mode, selecting the DDE mode will not affect the digital data output.

Dynamic DDE Control: The dynamic DDE setting is only affect by the spatial control and will automatically update the filter gain and control. Dynamic DDE is recommended for all users.

**FFC Utilities:** There are many applications that have different needs for their FFCs. The FFC utilities help lengthen the time between FFCs or help the duration of a FFC by shortening the frames integrated or help facilitate functionality that typically required a shutter but instead achieved using a non-volatile FFC (NVFFC). This tab allows you to perform an FFC and save or delete that correction.

**Shutter-less Gain Switch Calibration:** Tau2.1 was the first release to have radiometry for 640x512 and 336x256 resolution cameras. The Tau 2.4 release added low gain to the 336 and 640 resolution cameras. The Tau2 line was able to use auto gain to switch between high and low gain automatically by performing a FFC when switching between gain modes.

The Tau 2.7 and Quark 2.0 were the first to bring low gain to a 336x256 Quark and shutterless cameras. All Tau 2 and Quark 336 cameras have enough storage for two NVFFC maps. The Quark 2.0 and Tau 2.7 release have a new feature called Gain Switch Lens Mode and when GSLM is enabled the cameras can now use auto gain to switch into low gain mode without a shutter by having a NVFFC stored for each gain mode and applying the respective NVFFC depending on the gain mode.

To begin calibration place a black body subtending the entire FoV in front of the camera and press [Start] to begin the calibration. The camera will calculate and store new NVFFCs for each gain mode and after the calibration the GUI will enable the GSLM mode.

**FFC Frame Count:** The Tau 2.7, Quark 2.0 and later releases support variable FFC frame count integration for FFC calculations. The cameras can be set for 4, 8, or 16 frame FFC integration durations. Certain applications require very short FFC durations of four frames to keep objects of interest in the FoV longer and don’t mind performing FFCs more frequently, while other applications require much less frequent FFCs but don’t mind a long FFC duration of 16 frames.

**Supplemental Offset:** Supplemental Offset (Supplemental FFC) is a correction term intended to compensate for non-uniformity that occurs in thermally dynamic scenarios (for example, at start-up or when the camera is rapidly heated / cooled). The correction is associated with the installed lens, and some cameras support terms for up to 2 lenses.
For cameras equipped with an internal shutter, the correction factor is determined by analyzing
the difference between an internal FFC with the shutter and an external FFC through the lens. For
Tau 2 / Quark cameras that do not have a shutter, the correction map will be calculated by
analyzing the difference between imagery right after start-up and that at steady-state. This
capability is not typically required unless the lens is changed after delivery from FLIR.

To calibrate, click the Start button, and the
GUI will monitor the camera for
temperature stability. Once the test is
passed, it will prompt for a uniform target
to be placed in front of the camera. Click
Next. Wait for the calibration to complete.
Check the enable box and save settings on
the Setup Tab to make this power cycle
persistent.

For more information on Supplemental FFC, refer to the Application Note on Supplemental FFC.

**Splash Screen:** It is possible to
load a custom 256 color bitmap
for display in the analog video /
BT.656 output at start-up. Refer
to the Application Note on Splash
Screens for more information. Tau
2 / Quark cameras support
dynamically changing the dwell time with the Set button. This will apply the dwell time to the
splash screen number specified. Erasing the Splash Screen on a Tau 2 / Quark camera will result
in a black Splash Screen with a 2 second dwell time.

Camera Configuration: This is
used to load “pcf” files into the
camera that can perform a wide
variety of functions such as
updating firmware and/or
software, loading splash
screens, loading Discrete I/O
files, or loading different symbology files. Refer to the Application Note written to address the
individual topic of interest for more information.

### 5.15 AGC/DDE (advanced) Tab

The Tau2.7 and Quark 2.0 releases brought new AGC and image processing algorithms to the FLIR
compact core lines. With the arrival of the new AGC the automation of the algorithm has been increased
and presets defined on the standard AGC/DDE tab cover more user situations than ever before. Nearly
every use case will be optimized through the auto presets and adjusting the enhancements of DDE, ACE and SSO. The advanced AGC/ DDE tab is for users who prefer alternative AGC methods such as Auto Bright or Once Bright or have an atypical use case and would like to further dial in their AGC.

AGC Modes: There are four legacy AGC modes including Manual and Linear AGC discussed in section 5.9. The controls for linear AGC mode are adjustable by entering the value in the Automatic Parameters section: ITT Mean (sets gray scale midpoint) and Max Gain (AGC gain).

**Once Bright:** In this mode, the brightness will be set once when the mode is selected. The brightness (level) is calculated as the mean of the current scene when the Once Bright button is selected. The scene is mapped to the analog video using a linear transfer function. Image contrast can be adjusted by the Contrast slider. This is the only user adjustable parameter. Upon entry into the once bright mode, the currently-stored value of contrast is applied (i.e. the power-on defaults or the last saved values).

**Auto-Bright:** In this mode, the brightness (level) is calculated as the mean of the current scene just as in Once Bright mode. The difference with Auto-Bright is that the values selected for the start and end of the linear transfer function are automatically updated in real-time, not only at the start of AGC mode selection. The Brightness Bias offsets the displayed image in intensity. Upon entry into the auto bright mode, the currently-stored values of Contrast and Brightness Bias are applied (i.e. The power-on defaults or the last saved values).
**Automatic Parameters**: Used for fine tuning the Automatic and Linear Histogram, Information Based and Auto AGC modes.

SSO: Smart Scene Optimization described in section 5.9 can range from 0 to 100 percent and has an effect on auto and information based AGC algorithms.

Plateau Value: The plateau ranges from 0 to 4095 and affects automatic and information based AGC modes.

ITT Mean: The ITT mean ranges from 0 to 255 and affects automatic, information based and linear AGC modes.

Max Gain: The Max Gain ranges from 0 to 255 and affects automatic, linear and information based AGC modes.

AGC Filter: The AGC filter ranges from 0 to 255 and effects all dynamic AGC modes and determines how fast the AGC is allowed to change when the scene changes. A value of 1 being the slowest update rate, a value of 255 being the quickest update rate and zero causing no updates.

Tail Rejection: Tail Rejection ranges from 0 to 10 percent and affects all dynamic AGC modes by not using the upper and lower tail rejection percent in the AGC algorithm. This allows for the removal of anomalous pixels from skewing the AGC away from actual information.

**Linear Parameters**: Used for Manual AGC, Once Bright and Auto Bright AGC modes. Manual mode uses the contrast and brightness settings while Once Bright uses contrast, brightness and brightness bias. Auto Bright uses the same controls as Once Bright except the brightness parameter which is updated continuously based on the scene.

**Enhancements**: DDE and ACE are discussed further in section 5.9.

**Information Threshold**: Information based AGC modes determines where information in the scene is and favors contrast towards the information in the scene. The threshold defines the portions of the image that constitute as information.

### 5.16 Bad Pixel Elimination Tab

This tab requires access to the Advanced Tab. Refer to section 5.14 for instructions. All defective pixels are identified by FLIR as part of the standard factory-assembly process. However, it is possible that a camera in the field may have a pixel that needs replacing. This can particularly be the case if a Gain Calibration was performed on a lens that requires very high gain terms to correct for poor lens performance. Refer to the Application Note for Bad Pixel Killing for detailed instructions on killing pixels.

When eliminating pixels, it is important that the camera is not inverted and not reverted (See section 5.4). It is also important to note that the bad-pixel kill routine in the GUI only supports Tau and Quark cameras, and it does not support Photon cameras.
The bad pixel kill procedure involves taking a snapshot of a scene that clearly shows the bad pixel. A recommended procedure is to set the FFC mode to manual, wait for the temperature to drift, and then image a uniform scene. Refer to section 5.8 for information on Image Capture procedure.

![FLIR Camera Controller GUI – Bad Pixel Elimination](image)

**Figure 39: FLIR Camera Controller GUI – Bad Pixel Elimination**

Once a snapshot is captured, it will open a window similar to the Snapshot Viewer in Image Capture, but there is an additional pane on the right that shows a reticle with a zoomed subframe. Use the arrow keys to fine tune the cursor location until the offensive pixel is between the crosshairs. The zoom value of the subframe can be adjusted using the slider bar. Click Help on this window for more information on the Pixel Kill Utility.
Use the Enter key to select the pixel and add it to the pixel kill list.

Bad pixels can also be manually added to the list by entering the row and column, as shown to the right, and clicking Add.

Bad pixels can be removed from the Kill Pixel List by selecting them one by one and clicking Remove Selected Pixels. Use Ctrl to select multiple pixels or Shift to select a group of pixels to be removed. There is also a Remove All Pixels from the List button that will clear the list.

The list can be populated from a txt file. The format should be as follows:

```
Once the list is populated, click Set Bad Pixels to add these pixels to the camera’s bad pixel map. This will immediately affect the video output. Verify that the pixel is being replaced and click Save Bad Pixels to save this change in the camera. If the pixels are not being replaced, reset the camera using the Setup Tab to revert back to previous state.

5.17 Gain Calibration
If the lens on a camera is changed, it is possible to perform a gain calibration that will compensate for non-uniformities in the lens. This tab requires access to the Advanced Tab. Refer to section 5.14 for instructions.

Note: The Gain Calibration utility only supports Tau and Quark cameras, and it does not support Photon cameras.
With a Tau 2 or Tau 640, it is possible to select lens 2 for the calibration. This will preserve the factory calibration in lens 1, allowing to the ability to save a second calibration for lens 2. It is also possible to save separate lens maps for lens 1 and lens 2 for use with a dual FOV optic.

When starting a new calibration, keep the “Backup Current Gain Map” box checked. This will copy the existing gain map from the camera so that it can be recovered at a later time. With a Quark or Tau 320, the only option is to overwrite the calibration data for Lens 1, so it is a good idea to keep the “Backup Current Gain Map” box checked.

Click Start to begin the process. **Do not navigate away from this pane once the start button is clicked because it could change camera settings required for calibration.**

The camera will monitor its internal temperature and verify stability. If the camera has not been running long enough, a message will indicate that the temperature difference is too great. If it is within tolerance, the start button will change to “Capture1”, the camera will disable all correction terms, and it will prompt the user to place the hot blackbody in front of the camera. The optimal blackbodies will have a temperature difference of 20 C and will be in the approximate temperature range that the camera will typically be imaging. It is best to flood the aperture of the lens so that the blackbody is all the camera can see. Click “Capture1” and keep the hot source in front of the camera until prompted to remove it.
It will now prompt for a cold blackbody to be placed in front of the camera. Flood the aperture with a cold blackbody and click “Capture2”. It will take some time to capture and then it will calculate the new gain and perform an FFC. The correction terms will then be enabled and the quality of the image must be assessed. Keep the camera pointed at the blackbody until this step is complete so that it can use the blackbody for an External FFC if the camera is not equipped with an internal shutter.

At this point, the gain is stored in the camera’s DRAM and has not been saved to non-volatile memory. Assess the image using an analog monitor to ensure that the calibration was performed correctly. If an analog monitor is unavailable, go to the Video => Image Capture tab to take and retrieve a snapshot (see section 5.7). It is a good idea to first Erase Snapshots to ensure that the new capture is saved in buffer 1. If the calibration is not satisfactory, reset the camera to return to the previous gain map and start again.

![Figure 41: FLIR Camera Controller GUI – Image Capture](image)

If the calibration was successful, click “Save Gain”. The camera will take about 30 seconds to copy the calibration to the camera’s non-volatile memory, overwriting the previous calibration. A notification will popup when the process is complete. **Do not remove power to the camera during this time.**

Verify that the calibration was saved successfully by resetting the camera and evaluating the image for the applied gain. Resetting the camera will also restore previously saved power on default settings. If this calibration was performed on Lens 2, remember to make sure to select Lens 2 and then Save Settings on the Setup Tab to ensure that this calibration map is loaded when the camera starts up.
If it is necessary to restore, a previous gain calibration, then click the “Restore Gain” button. It will prompt the user to select the gain map. The GUI saves the gain map with the SN of the camera and the date that the map was copied from the camera. Select the correct file and click Open.

**Restore Factory Bad Pixels**: This will restore the bad pixel map to the settings from the factory. This will erase the saved bad pixels that were marked as bad on the Bad Pixel Elimination Tab in section 5.16.
FLIR Camera Controller GUI User’s Guide

© FLIR Commercial Systems, 2011. All rights reserved worldwide. No parts of this manual, in whole or in part, may be copied, photocopied, translated, or transmitted to any electronic medium or machine readable form without the prior written permission of FLIR Commercial Systems.

Names and marks appearing on the products herein are either registered trademarks or trademarks of FLIR Commercial Systems and/or its subsidiaries. All other trademarks, trade names, or company names referenced herein are used for identification only and are the property of their respective owners.

Libération fonts are copyright 2009 by RedHat and are used under authority of the GNU public license. Information about these fonts and the GNU public license can be found at: https://www.redhat.com/promo/fonts/.

This product is protected by patents, design patents, patents pending, or design patents pending.

If you have questions that are not covered in this manual, or need service, contact FLIR Commercial Systems Customer Support at 805.964.9797 for additional information prior to returning a camera.

This documentation is subject to change without notice.

This equipment must be disposed of as electronic waste.
Contact your nearest FLIR Commercial Systems, Inc. representative for instructions on how to return the product to FLIR for proper disposal.

FCC Notice. This device is a subassembly designed for incorporation into other products in order to provide an infrared camera function. It is not an end-product fit for consumer use. When incorporated into a host device, the end-product will generate, use, and radiate radio frequency energy that may cause radio interference. As such, the end-product incorporating this subassembly must be tested and approved under the rules of the Federal Communications Commission (FCC) before the end-product may be offered for sale or lease, advertised, imported, sold, or leased in the United States. The FCC regulations are designed to provide reasonable protection against interference to radio communications. See 47 C.F.R. §§ 2.803 and 15.1 et seq.

Industry Canada Notice. This device is a subassembly designed for incorporation into other products in order to provide an infrared camera function. It is not an end-product fit for consumer use. When incorporated into a host device, the end-product will generate, use, and radiate radio frequency energy that may cause radio interference. As such, the end-product incorporating this subassembly must be tested for compliance with the Interference-Causing Equipment Standard, Digital Apparatus, ICES-003, of Industry Canada before the product incorporating this device may be: manufactured or offered for sale or lease, imported, distributed, sold, or leased in Canada.

Avis d’Industrie Canada. Cet appareil est un sous-ensemble conçu pour être intégré à un autre produit afin de fournir une fonction de caméra infrarouge. Ce n’est pas un produit final destiné aux consommateurs. Une fois intégré à un dispositif hôte, le produit final va générer, utiliser et émettre de l’énergie radiofréquence qui pourrait provoquer de l’interférence radio. En tant que tel, le produit final intégrant ce sous-ensemble doit être testé pour en vérifier la conformité avec la Norme sur le matériel brouilleur pour les appareils numériques (NMB-003) d’Industrie Canada avant que le produit intégrant ce dispositif puisse être fabriqué, mis en vente ou en location, importé, distribué, vendu ou loué au Canada.

EU Notice. This device is a subassembly or component intended only for product evaluation, development or incorporation into other products in order to provide an infrared camera function. It is not a finished end-product fit for general consumer use. Persons handling this device must have appropriate electronics training and observe good engineering practice standards. As such, this product does not fall within the scope of the European Union (EU) directives regarding electromagnetic compatibility (EMC). Any end-product intended for general consumer use that incorporates this device must be tested in accordance and comply with all applicable EU EMC and other relevant directives.